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Section 1
Installation
1.1 About this Manual
This manual is designed for both the Windows and Macintosh version of the software. The
two programs, WinMelt and MacMelt, are nearly identical. The screen images shown in this
manual are from WinMelt. The screen images for MacMelt look very similar to WinMelt.
Any major differences between the programs will be described in the text.

1.2 The Software Installation Disks
Floppy disks are sensitive to dust and unwanted magnetic fields, and may become unreadable. Prior to installation you should make a copy of your installation disks and store them in
a safe place for backup purposes. Please note that it is illegal to make copies of the program
for other purposes than stated in the software license. By installing the software, you accept
the terms of the software license.

1.3 WinMelt System Requirements
The minimum system requirements for running WinMelt are:
PC with a 486 or faster CPU
4 MB of free RAM
3.5" HD floppy disk drive
4 MB of free hard disk space
Windows-compatible color graphics adapter and monitor
Microsoft Windows 3.11, Windows 95, Window NT 3.51 or later
A Windows-compatible color printer is recommended.

1.4 MacMelt System Requirements
The minimum system requirements for running MacMelt are:
Apple Macintosh II (68030) or faster CPU
3 MB of free RAM
3.5" HD floppy disk drive
4 MB of free hard disk space
Color monitor
Apple Mac operating system 7.0 or later
A color printer is recommended.

1.5 WinMelt Installation on Windows 3.1x Systems
WinMelt is designed for 32-bit Windows operating systems. The recommended operating systems for WinMelt are Windows 95 or Windows NT. In order to use WinMelt on computers with Microsoft Windows 3.11, the installation of an extension called Win32s is required.
Win32s may already be installed on your computer if you are already running other 32-bit software. The Win32s extension is provided by Microsoft, and is included with your WinMelt soft-
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ware on two disks for your convenience. Follow this procedure if installation of Win32s is
required for your computer.
1. Start Microsoft Windows.
2. Insert Microsoft Win32s disk 1 into the floppy disk drive.
3. Choose Run from the File menu in Program Manager.
4. Type “a:\setup.exe” and choose OK.
5. Follow the instructions that appear on screen.
6. When the Win32s system is successfully installed you can proceed to install WinMelt.
7. Insert the WinMelt disk 1 into the floppy disk drive. There should be two WinMelt disks.
Create a directory on the hard drive named "WinMelt".
8. Drag all the files from disk 1 into the "WinMelt" folder.
9. After the files have been copied, eject the disk.
10. Insert WinMelt disk 2. Repeat steps 8 and 9.

1.6 WinMelt Installation on Windows 95 and Windows NT Systems
1. Insert the WinMelt disk 1 into the floppy disk drive. There should be two WinMelt disks.
2. Choose Run from the Start menu.
3. Type "a:\setup.exe" and choose OK.
4. Follow the instructions that appear on screen.

1.7 MacMelt Installation on 680x0 and Power Macintosh
Systems
1. There should be two MacMelt disks. Turn on the computer with the extensions off (hold
down the shift key before turning on the Macintosh).
2. Insert the MacMelt disk 1 into the floppy disk drive and double-click on the disk icon
"Install MacMelt" to launch the installer program.
3. Choose the destination location for MacMelt, then press the Install button.
4. Follow the instructions that appear on the screen.
5. Restart the computer.

1.8 Registration and Technical Support
Please register the program using the enclosed registration form. Registering will assure
that you receive information about updates. For technical service, call your Bio-Rad office or
in the U.S. call 1-800-4BIORAD (1-800-424-6723).
WinMelt and MacMelt were developed by MedProbe AS, Oslo, Norway.
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Section 2
Program Overview
The thermodynamics of the transition of double-stranded to single-stranded DNA have
been described by the computer program Melt87 developed by Lerman and Silverstein.1 The
WinMelt/MacMelt software is based on the algorithm from the Melt87 software and has been
given an easy-to-use graphical interface for Windows and Macintosh. The software is a
powerful tool for analyzing the melting profile of any DNA sequence up to 10,000 base-pairs.
A melt profile will show regions of theoretical high and low melting domains of a known
sequence. Location of primers and GC clamps can be optimized by analyzing the placement
effect on the DNA melting profile. The software allows entering, editing, analyzing,
displaying, and saving data from any sequence. The melt profiles of up to ten sequences can
be overlaid on one graph and the data can be exported to other graphing programs. The main
features of the software are:
•

Simple sequence editor for sequence entry or modification.

•

Up to 50 sequences with a maximum of 10,000 base-pairs (9,000 in Windows 3.1x) each
can be included in one project.

•

Up to 10 melting profiles can be graphed together.

•

Sequences can be imported from text files in GenBank, EMBL, FASTA or plain format.

•

Sequences are exported in FASTA format.

•

Fast melting profile calculation.

•

The melting profile is graphed at melting probability levels of 5%, 25%, 50%, 75% or
95%.

•

Melting profile data can be exported to a text file for use with other applications.

•

Melting profile graphs can be exported to an image file in PICT (MacMelt) or EMF
(WinMelt) format for use with other applications.

•

Graph zooming using the mouse or by direct entry of sequence and temperature ranges.

•

Sequences and melting profile graphs can be printed.
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Section 3
Quick Tutorial
This tutorial section allows you to work with the main features of the program. The
tutorial will cover.
•

How to start the program

•

Importing a sequence

•

Duplicating a sequence

•

Editing the sequence

•

Printing a sequence

•

The melting profile graph

•

Editing the graph axis

•

Printing the graph

•

Exporting a sequence, melt profile data, and graph

•

Saving the project

3.1 How to Start the Program
Starting WinMelt on Windows 3.1x Systems
To start the WinMelt program go to the Program Manager and open the "WinMelt" group.
Double-click the "WinMelt.exe" icon to launch the program.
Starting WinMelt on Windows 95 and Windows NT Systems
To start the WinMelt program go to the Start menu and choose "WinMelt" under
"Programs".
Starting MacMelt
To start the MacMelt program, double-click on the "MacMelt 2.0" program icon.

3.2 Importing a Sequence
When the program is loaded the main screen will appear as shown in Figure 3.1. The
main screen contains the Project View, which is currently empty.

Fig. 3.1. The Project View window.
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A sequence can be added to the project by two methods: 1) The sequence can be imported from a text file, or 2) the entire sequence can be typed into the program from the keyboard.
In this tutorial the sequence will be imported into the Project View. Choose Import from the
Sequence menu. A standard open dialog box will appear. Open the text file "TP53ex8 wildtype" provided with the program. The new sequence will be imported into the Project View
as shown in Figure 3.2. The information displayed in the Project View contains the name of
the sequence, the graphing option, the melting probability, the length of the sequence, and
the beginning portion of the sequence.

Fig. 3.2. Imported TP53ex8 wild-type sequence.

3.3 Duplicating a Sequence
Before any changes are made to the sequence, a duplicate sequence will be created. This
duplicate sequence will be used to create a mutated sequence. Click on the icon in front of the
TP53ex8 wild-type sequence in the Project View, then select Duplicate from the Sequence
menu. A new sequence will appear in the Project View just below the first sequence as shown
in Figure 3.3. The two sequences are identical, except that the new sequence is named "Copy
of TP53ex8 wild-type".

Fig. 3.3. Duplicating the TP53ex8 wild-type sequence.

3.4 Editing a Sequence
A single base mutation will be introduced in the duplicated sequence. Double-click on the
icon in front of the "Copy of TP53ex8 wild-type" sequence or select Display from the
Sequence menu. The Sequence Display window will appear (Figure 3.4).
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Fig. 3.4. Sequence Display window for the Copy of TP53ex8 wild-type sequence.

Introduce a "G to A" mutation at position 47 by selecting the "G" in the first line, fourth
position from the right. Replace the "G" by typing in a lower case letter “a” as shown in Figure 3.5. Lower case letters can be used to highlight important bases. Change the description
of the sequence by selecting the text "Copy of TP53ex8 wild-type" with the mouse, and then
type in the new name "TP53ex8 mutant".

Fig. 3.5. Creating a single base mutation at position 47 in the TP53ex8 mutant sequence.

The Sequence Display window also shows the melting probability and whether the melting data will be graphed. The melting probability can be set to 5%, 25%, 50%, 75% or 95%,
with the default setting of 50%. The melting profile data for the current sequence can be
graphed when the Show graph box is checked. Finally, click OK to save the changes and
return to the Project View (Figure 3.6). After exiting the Sequence Display window, the melting profile of the new sequence is calculated. With a short sequence and a fast computer it
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should only take a fraction of a second. However, if the sequence is long or if the computer
is not fast, a delay may be noticed.

Fig. 3.6. Project View window with wild-type and mutant TP53ex8 sequences.

3.5 Printing a Sequence
To print the mutant sequence, first select the "TP53ex8 mutant" sequence in the Project
View by clicking on the sequence icon, then select Print from the File menu. The standard
Print dialog box will appear. If necessary, select any print options and then click OK. To see
what will be printed before printing, use the Print Preview command on the File menu. To
print both the wild-type and mutant sequences, click on the mutant sequence icon so that
neither sequences are selected. Then print the sequences by selecting the Print command.

3.6 The Melting Profile Graph
To see the melting profile for the two sequences, select Show from the Graph menu.
The Graph View window will appear as shown in Figure 3.7. The abscissa (x-axis)
corresponds to the sequence position and the ordinate (y-axis) corresponds to the melting
midpoint in degrees Celsius (°C). The wild-type sequence is plotted in black, the mutant is plotted in yellow.

Fig. 3.7. Graph View window with wild-type and mutant TP53ex8 sequences.

3.7 Editing the Graph axis
The axis of the graph can be changed by selecting Edit Graph Axis from the Graph
menu. Change the temperature range to 60 °C for the low and 100 °C for the high and then
click OK (Figure 3.8). The melt profile data will be graphed using the new coordinates. The
axis can also be changed by selecting an area inside the graph. Using the left mouse button,
click and drag an area in the graph. The melt profile will be graphed to the new coordinates.
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To reset the graph to the default settings, select Default Graph Axis from the Graph
menu. WinMelt users can also click on the right mouse button. The temperature range will be
set to 20–120 °C and the sequence range will include the longest sequence in the project.

Fig. 3.8. Edit Graph Axis window.

3.8 Printing the Graph
When the graph is printed the sequence information is also printed. To print the graph, first
ensure that the Graph View window is the active window, then select Print from the File
menu. A standard Print dialog box will appear. If necessary, select any print options and then
click OK. To see what will be printed before printing, use the Print Preview command on the
File menu.

3.9 Exporting a Sequence, Melt Profile data, and Graph
The new mutant sequence can be exported or saved outside the project file for later use.
To save the mutant sequence, select the TP53ex8 mutant sequence in the Project View. Then
select Export from the Sequence menu. A standard file save dialog box will appear. Save the
new sequence as "TP53ex8 mutant". The sequence will be saved in the FASTA format.
The melting profile data for each sequence can be exported or saved for viewing in another
program (e.g. a spreadsheet program). To save the melting profile data for the mutant sequence,
select the TP53ex8 mutant sequence in the Project View. Then select Export data from the
Sequence menu. A standard File Save dialog box will appear. Save the melting profile data
as "TP53ex8 mutant data". The melting profile data will be saved as text file.
The graph can be saved as an image file for later importing into another application. To
save the graph, select Export from the Graph menu. A standard File Save dialog box will
appear. Save the graph as "TP53ex8 graph".

3.10 Saving the Project
It is recommended that the project be saved. When a project is saved, all sequences,
sequence descriptions, and options are stored in the project file. The melting profiles and
graphs are recalculated when the file is reopen. Select Save from the File menu to save the
project. A standard File Save dialog box will appear. Save the project as "TP53ex8 project".
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Section 4
Using WinMelt/MacMelt for Denaturing Gradient Gel
Electrophoresis
Calculating a melt profile for a wild-type or known sequence using the WinMelt/MacMelt
software is a good initial step in mutation detection using denaturing gel electrophoresis. The
term melt refers to the change in the structure of DNA from an orderly helix to a disordered
structure without base-pairs. The program calculates the midpoint temperature (Tm) at which
each base-pair is at 50/50 equilibrium between the helical and melted states. This data is then
plotted, Tm versus the sequence base, to create a melting profile. The goal of mutation
detection by denaturing gel electrophoresis is to manipulate the sequence so that the region of
interest is in the lowest melting domain. This requires the proper placement of GC clamps to
attain this. The GC clamp is typically 40 base-pairs in length and creates a region of high
melting temperature.2, 3
After analyzing a sequence with MacMelt or WinMelt, the DNA samples are run on a
denaturing gradient gel for screening mutations within the sequence. Denaturing Gradient
Gel Electrophoresis (DGGE) is an electrophoretic method to identify single base changes in
a segment of DNA. The separation techniques on which DGGE is based were first described
by Fischer and Lerman.4 DGGE samples can be run on the Bio-Rad DCODE denaturing gel
electrophoresis system for mutation detection.
When running a denaturing gradient gel, both the mutant and wild-type DNA fragments
are run on the same gel. This way one can detect a mutation by seeing a band shift on the gel.
The mutant and wild-type fragments are typically amplified by the polymerase chain reaction
(PCR) to make enough DNA to load on the gel. Optimal resolution is attained when the
molecules do not completely denature. The addition of a 30–40 base-pair GC clamp to one of
the PCR primers ensures that the region screened is in the lower melting domain and the
DNA will remain partially double-stranded.
Other methods that use the melt profile information from MacMelt or WinMelt include
Constant Denaturing Gel Electrophoresis (CDGE) and Temporal Temperature Gradient Gel
Electrophoresis (TTGE). CDGE is a modification of DGGE where the denaturant
concentration found to give optimal resolution from a parallel or perpendicular DGGE gel is
held constant.5 A CDGE gel can be used to rapidly screen samples for the presence of a
mutation. TTGE exploits the principle upon which DGGE is based, without the requirement
for a chemical denaturing gradient. A gel containing a constant concentration of denaturants
is used and during electrophoresis, the temperature is increased gradually and uniformly. The
result is a linear temperature gradient over the time course of the electrophoresis run. Thus,
a denaturing environment is formed by the constant concentration of denaturants in the gel in
combination with the temporal temperature gradient.
A sequence from the betaglobin gene (exon 1) will be used to illustrate how the software
works in proper placement of GC clamps and visualizing difference in the melt profile of
wild-type and mutant sequences. The 299 base-pair betaglobin sequence is first imported into
the project. Figure 4.1 shows the Sequence Display window for the imported sequence.
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Fig. 4.1. A 299 base-pair betaglobin sequence (exon 1).

Figure 4.2 shows the melting profile for the betaglobin sequence graphed using the 50%
melted probability. The 50% melting probability is typically used for analyzing melt profiles
for denaturing gel electrophoresis. From the melting profile, it can be seen that there are two
low-temperature melting regions and one high-temperature melting region in the middle of the
sequence. A 40 base-pair GC clamp is needed to create a region of high melting temperature
above 80 °C. The GC clamp places the sequence of interest into the lowest melting region and
the mutations in this region can be detected by denaturing gradient gels.2,3

Fig. 4.2. The melting profile for the example betaglobin sequence.

The GC clamp can be added to the 5' or 3' end of the sequence. In this example, the
40 base-pair GC clamp is added to the 3' end of the sequence using lower case letters
(Figure 4.3).
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Fig. 4.3. The example betaglobin sequence with a 40 bp GC clamp attached to the 3’ end.

Figure 4.4 shows the melting profile for the 339 base-pair GC clamped betaglobin sequence
using the 50% probability. From the melting profile, it can be seen that there is now one low
melting region and a high melting region that is formed by the GC clamp. The melting profile
shows how the addition of the GC clamp lowered the theoretical melting temperature of bases
80 to 185 shown in Figure 4.2. The GC clamp can also be tried on the 5' end of the sequence.

Fig. 4.4. The melting profile of the example betaglobin sequence with a 3' GC clamp attached.

The graph in Figure 4.5 shows different melt profiles for a mutant betaglobin sequence
with a "T to G" mutation at base 51 and the wild-type sequence. The difference in the melt
profile between the two sequences is easily seen when the axis is changed to show the 1 to
136 base-pair region. Since it is possible to see a different melt profile for the mutant and
wild-type sequences using the software, it should therefore be possible to resolve the mutant
and wild- type sequences on a DGGE gel.
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Fig. 4.5. The melting profiles for a mutant and wild-type sequence from a portion of the betaglobin gene (exon 1).

Sometimes the addition of a GC-clamp to the end of a sequence does not work and
optimizing the location of the GC-clamp is required. Figure 4.6 shows the melting profile for
a 300 base-pair sequence with a 40 base-pair GC clamp attached on the 3' end using the 50%
probability. From the melting profile, it can be seen that there are two low melt regions (bases
1–100, 155–250) and a single high melt region in the middle of the sequence (bases 100–155).
This melt profile may cause mutations in the 170–260 base-pair region to be undetected on a
denaturing gradient gel. It is recommended to use a melt profile that is flat or is decreasing in
temperature from the GC clamp so that the region of interest is in the lowest melting domain.
In this example the sequence may have to be split up into two sequences. The GC clamp can
be added to the 3' end at base 155 for screening mutations in the 1–155 base region and added
to the 5' end at base 100 for screening mutations in the 155–250 base region.

Fig. 4.6. The melting profile of a 300 base-pair sequence with a 3' GC clamp attached.
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Section 5
The Project View
The Project View is a window that shows an overview of the project file (Figure 5.1).
The name of the project is shown in the window title. Each line in the Project View represents
one sequence. For each sequence in the project, the following information is shown:
•

A small icon for each sequence

•

The sequence description

•

Whether or not to show the melting profile graph for this sequence

•

The melting probability used for melting profile calculations

•

The sequence length

•

The initial part of the sequence

Fig. 5.1. The Project View window.

Projects are created, opened, and saved using the commands on the File menu (Section
7.1) or buttons on the toolbar (Section 9). When the Project View is active the sequences in
the project can be printed by selecting Print from the File menu or by pressing the Print
button in the toolbar. If a sequence is selected, only that sequence will be printed. If no
sequences are selected, then all the sequences in the Project View will be printed.
When importing a sequence into the Project View, the text file should contain only the
sequence or conform to the FASTA, GenBank or EMBL flat file formats. Illegal symbols
will be removed and the sequence will be truncated to 10,000 nucleotides if necessary
(9,000 in Windows 3.1x). Characters different from "acgtu and ACGTU" will not be accepted. Both upper and lower case letters can be used. The case of the letters will be preserved
when the sequence is imported. The maximum number of sequences that can be in one project is 50.
The sequences and related information are manipulated using the commands in the
Sequence menu. The Sequence menu commands are.
New
Duplicate
Display

Adds a new empty sequence.
Duplicates a selected sequence.
Displays the properties of a selected sequence and allows editing of the
sequence.

Delete
Import

Deletes a selected sequence.
Imports a sequence from a text file in GenBank, EMBL, FASTA or plain
text file format.

Export
Export Data

Exports a selected sequence to a text file in FASTA format.
Exports the melting profile data to a text file for processing with another
application.
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When a project is saved, all sequences, sequence descriptions, and options are stored in
the project file. The actual melting profiles are not stored in the project file. The melting
profiles and graphs are calculated when the file is open. The calculation also takes place
automatically when a sequence is imported, when the sequence is edited, and when the
melting probability setting is changed.

Section 6
The Sequence Display
The Sequence Display is a window that shows information on a sequence from the
Project View (Figure 6.1).

Fig. 6.1. The Sequence Display window.

When a sequence is present in the Sequence Display window it can be viewed and edited.
A new sequence can be typed into the window using the keyboard. The window will show up
to 500 nucleotides divided on 10 lines of 50 nucleotides each. Use the scroll bar to see a
different part of the sequence. A sequence up to 10,000 nucleotides can be entered (9,000 in
Windows 3.1x). Characters different from "acgtu and ACGTU" will not be accepted. Both
upper and lower case letters can be used.
When editing a sequence the Cut, Copy, Paste, and Select All functions are active. For
WinMelt users these functions can be found under the Edit menu in the Sequence Display
window and these functions can also be activated by clicking the right button on the mouse.
For MacMelt users these functions can be found under the Edit menu in the Menu heading
at the top of the screen.
The melting probability calculation can be set to 5%, 25%, 50%, 75% or 95% by using
the arrow scroll button. The default melting probability setting is 50%. The melting profile data
for the sequence can be graphed when the Show graph box is checked. Uncheck the Show
graph box if the sequence is not to be graphed. The sequence name can be changed by
typing in a new name in the sequence description box.
If the sequence or the melting probability settings have changed, the melting profile will
be recalculated and the Graph View will be updated. Click OK to exit the Sequence Display
or click Cancel to close the Sequence Display without saving changes to the sequence or the
other options.
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Section 7
The Graph View
The Graph View shows the melting profile graphs of the sequences in the project that
were selected to be graphed (Figure 7.1). A legend with the colors for the different sequences
and a description of each graphed sequence is shown. Up to ten graphs can be shown
simultaneously in the Graph View.

Fig. 7.1. The Graph View window.

The title of the window contains the file name of the project. The melting probability
graphed will be the one selected for each sequence. The melting profile graphs of the sequences
are shown in different colors (black, red, green, blue).
The Graph View and related information are manipulated using the commands on the
Graph menu. The graph menu commands are:
Show or Hide Graph
Edit Graph Axis

Displays or hides the Graph View window.
Displays a window for changing the sequence range and temperature range coordinates.

Default Graph Axis

The temperature range will be set to 20–120 °C and the sequence
range will include the longest sequence in the project.
Exports the melting profile graph as a image file.

Export Graph

The Graph View can be stretched to any size. The graph will automatically reformat to
fit the size of the window. The Show or Hide Graph command on the Graph menu or the
Show or Hide Graph button in the toolbar is used to show or hide this view.
There are two methods for adjusting the graph axis. One method is to use the mouse to
select the part of the graph you are interested in. Click and drag the area to be graphed using
the left mouse button. The axis will change to fit the selected area. The other method for
changing the axis is by using the Edit Graph Axis command on the Graph menu or the Edit
Graph Axis button in the toolbar (Figure 7.2). The sequence and temperature range can be
changed by typing in the new values. The graph can be zoomed out to a full view by the
Default Graph Axis command on the Graph menu. WinMelt users can also use the right
mouse button.
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Fig. 7.2. Edit Graph Axis window.

The graph can be saved as an image file for importing into another application. To save
the graph, select Export from the Graph menu. In WinMelt, the graph is exported in Windows Enhanced Metafile format (EMF). In MacMelt, the graph is exported in PICT format.
When the graph is printed the sequence information is also printed (Figure 7.3). To print
the graph, select Print from the File menu or the Print button in the toolbar. The Graph View
window must be the active window for printing. To see what will be printed before printing,
use the Print Preview command on the File menu.
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DNA melting profile graph
Betaglobin
100.0

94.0

88.0

82.0

76.0

70.0
1

69

137

205

273

341

Sequence position (bp)
Betaglobin exon 1 with GC-clamp
Melting probability: 50%
GGGCTGGGCA TAAAAGTCAG GGCAGAGCCA TCTATTGCTT
CTGACACAAC TGTGTTCACT AGCAACCTCA AACAGACACC
TGACTCCTGA GGAGAAGTCT GCCGTTACTG CCCTGTGGGG
GTGGATGAAG TTGGTGGTGA GGCCCTGGGC AGGTTGGTAT
AGACAGGTTT AAGGAGACCA ATAGAAACTG GGCATGTGGA
ACTCTTGGGT TTCTGATAGG CACTGACTCT CTCTGCCTAT
GGGCGGGGGC GGCGGGACGG GCGCGGGGCG CGGCGGGCG
Mutant Betaglobin exon 1 with GC-clamp
Melting probability: 50%
GGGCTGGGCA TAAAAGTCAG GGCAGAGCCA TCTATTGCTT
CGGACACAAC TGTGTTCACT AGCAACCTCA AACAGACACC
TGACTCCTGA GGAGAAGTCT GCCGTTACTG CCCTGTGGGG
GTGGATGAAG TTGGTGGTGA GGCCCTGGGC AGGTTGGTAT
AGACAGGTTT AAGGAGACCA ATAGAAACTG GGCATGTGGA
ACTCTTGGGT TTCTGATAGG CACTGACTCT CTCTGCCTAT
GGGCGGGGGC GGCGGGACGG GCGCGGGGCG CGGCGGGCG

Fig. 7.3. Printed graph and sequence information.
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Section 8
Menu Descriptions
8.1 File Menu
The File menu contains command for creating, opening, saving, and printing projects.
The command for exiting the program is also on the File menu.

New
The New command will open a new, empty project window. The commands on the Sequence
menu will be enabled, allowing you to add a new or imported sequence into the project.
Open
The Open command will open an existing project. The standard File Open dialog box will be
shown to allow a project file to be selected from any folder (directory). The file types shown
in the File Open dialog box can be selected. Initially, only WinMelt/MacMelt 2.0 project files
will be shown. The file format used for projects is proprietary to the WinMelt/MacMelt
software. On Windows systems, the file name extension ".mpj" is used for WinMelt projects.
Close
The Close command will close the current project. A prompt will appear to save your project
if it has been modified since the last save.
Save
The Save command saves the current project. The standard File Save dialog box will be
shown. If your project already has a name, it will be saved under that name. If the project
does not have a name, this command will behave as the Save As command.
Save As
The Save As command will save the current project with a given name. The standard File
Save dialog box will be shown. On Windows systems, the file name extension ".mpj" must
be used. The file format used is proprietary to the WinMelt/MacMelt software.
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Print
The Print command will print the contents of the active window. The command will open the
standard Print dialog box and allow selection of printing options. If the active window is the
Graph View, the graph and graphed sequence information will be printed. If the active
window is the Project View, one or all sequences will be printed. If only one sequence is
selected in the Project View, only that sequence will be printed.
Print Preview
The Print Preview command will show a preview of what the printed page would look like
if printed. The preview window contains buttons for moving from page to page and for
zooming. The print preview window must be closed to return to the main program.
Print Setup
The Print Setup command opens the standard Print Setup dialog box. This dialog box will
allow various printing options like the page size and orientation to be changed.
Names of the four most recently used files
The names of up to four of the most recently used projects files will also appear on the File
menu. Selecting one of these file names will quickly open the associated file.
Exit
The Exit command will end the program. Before leaving the program a prompt will appear
to save modified projects. In MacMelt, the command Quit is used instead of Exit.

8.2 Edit Menu
The commands on the edit menu can be used to edit the sequence in the Sequence
Display window. Keyboard short cuts can also be used to access the commands. In addition
to the commands on the edit menu, the usual editing keys like the arrows, delete, insert, home,
and end will work.

Undo
The Undo command reverses the effect of the last editing command. Use this command if you
have deleted or changed some text by accident. This command does not work in MacMelt.
WinMelt keyboard short cut: Control-Z
Cut
The Cut command deletes the selected text and places the deleted text on the clipboard for later
use. The text on the clipboard can later by inserted by the Paste command. The text on the
clipboard is also available for pasting into another application.
WinMelt keyboard short cut: Control-X
MacMelt keyboard short cut: Command-X
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Copy
The Copy command copies the selected text to the clipboard for later use. The selected text
is not deleted. The text on the clipboard can later be inserted by the Paste command. The text
on the clipboard is also available for pasting into another application.
WinMelt keyboard short cut: Control-C
MacMelt keyboard short cut: Command-C
Paste
The Paste command inserts the text from the clipboard to the current cursor position. The text
that has been placed on the clipboard can also come from another application. This function can
transfer a sequence from other sequence analysis program into WinMelt/MacMelt.
WinMelt keyboard short cut: Control-V
MacMelt keyboard short cut: Command-V
Select All
The Select All command selects all of the text. Use this function to quickly select all of the
sequence or other text for later copying or deletion.

8.3 Sequence Menu
The Sequence Menu contains commands for adding, editing, deleting and exporting
sequences. The commands are used with the Project View.

New
The New command will insert an empty sequence into the project. There can be a maximum
of 50 sequences in one project.
Import...
The Import command will import a sequence from a text file into the current project. A
standard File Open dialog box will be shown to select the file containing the sequence. The
sequence will be truncated to 10,000 nucleotides if longer (9,000 in Windows 3.1x). Only
the nucleotide symbols "acgtu and ACGTU" are allowed. Other symbols will be removed
from the sequence. Sequence files in GenBank, EMBL, FASTA, or plain text format will be
automatically recognized.
In WinMelt the dialog box will initially show only files ending with the ".dna" extension.
Select "All files (*.*)" to show all files.
Display...
The Display command will open the Sequence Display window of the selected sequence from
the project. The Sequence Display window allows editing of the sequence, the description,
melt probability calculation, and graphing option.
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Delete
The Delete command will delete the currently selected sequence from the project.
Duplicate
The Duplicate command will make an identical copy of the selected sequence. This can be
handy to create a mutant sequence by first "cloning" a sequence and then editing the copy.
Export Sequence
The Export command exports the sequence in FASTA format to a text file. The text file will
contain a single description line starting with the ">" character, followed by lines of sequence.
The command will open a dialog box that allows you to choose where the file is to be stored.
Export Data
The Export Data function exports the melting profile data to a text file. The command will
open a dialog box that allows you to choose where the file is to be stored. The data are stored
as a plain text file with one line per base-pair, containing the predicted temperature at that
position. The melting temperature is not predicted for the first and last base-pair, so there will
be two fewer lines than the number of base-pairs in the sequence.

8.4 Graph Menu

Show or Hide Graph
The Show or Hide Graph command will show or hide the Graph View.
Edit Graph Axis
The Edit Graph Axis command allows changing the axis values of the graph. The temperature
range (y-axis) can be adjusted from 0–120 °C. The sequence position (x-axis) can be adjusted
from 0–10,000 base-pairs.
Default Graph Axis
The Default Graph Axis command will adjust the axis so a full view of the melting profile
graph can be seen. The temperature range is set to 20–120 °C, and the sequence range is set
to include all of the longest sequence in the project. WinMelt users can also zoom out by
clicking the right mouse button on the graph.
Export
The Export command will export the melting profile graph to an image file in the Windows
Enhanced Metafile (EMF) format in WinMelt, or PICT format in MacMelt.
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8.5 View Menu

Toolbar
The Toolbar command will show or hide the toolbar. A tick mark will appear on the menu
when the toolbar is shown. The toolbar can be moved around on the screen by dragging it
with the mouse.
Status Bar
The Status Bar command will show or hide the status bar. A tick mark will appear on the
menu when the status bar is shown.

8.6 Window Menu

Cascade
The Cascade command resizes and moves the open windows on the screen. The windows are
resized to their default size and moved into a partially overlapping position. Only the active
window is completely visible in front.
Tile
The Tile command resizes and moves the open windows on the screen so that they fill equally
sized non-overlapping areas on the screen. The active window is displayed in the upper left
corner. This can be useful to quickly arrange a few windows. The visible part of each window
will be small if too many windows are open on a low-resolution screen.
Arrange Icons
The Arrange Icons command automatically arranges the icons of the minimized windows
from the left along the bottom of the screen. Minimizing a window is useful to temporarily get
it out of the way. This command only works in WinMelt.
Titles of open windows
Below the separator line on this menu is a list of the open windows. Select one of the items
to move the select window to the front and make it active.
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More Windows...
If there are many open windows on the screen, the More Windows command will appear.
Choosing this command will show a list of all the windows and allow one to be selected to
make it active.

8.7 Help Menu

Help Topics
The Help Topics command will display on-line help information for the program. The information is similar to the software manual.
About WinMelt/MacMelt
The About WinMelt/MacMelt command displays copyright and version information on the
program.

Section 9
Toolbar Descriptions

New
The New button will open a new, empty project window. The commands on the
Sequence menu will be enabled, allowing insertion of a new or imported sequence into the
project.
Open
The Open button will open an existing project from disk. The standard File Open
dialog box will be shown to allow a project file to be selected from any folder (directory).
The file types shown in the File Open dialog box can be selected. Initially, only
WinMelt/MacMelt 2.0 project files will be shown. The file format used for projects is
proprietary to the WinMelt/MacMelt software. On Windows systems, the file name extension
".mpj" is used for WinMelt projects.
Save
The Save button saves the current project to disk. The standard File Save dialog box
will be shown. If your project already has a name, it will be saved under that name. If the
project does not have a name, this command will behave as the Save As command.
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Cut
The Cut button deletes the selected text and places the deleted text on the clipboard
for later use. The text on the clipboard can later be inserted by the Paste command. The text
on the clipboard is also available for pasting into another application.
Copy
The Copy button copies the selected text to the clipboard for later use. The selected
text is not deleted. The text on the clipboard can later be inserted by the Paste command. The
text on the clipboard is also available for pasting into another application.
Paste
The Paste button inserts the text from the clipboard to the current cursor position.
The text that has been placed on the clipboard can also come from another application. This
function can transfer a sequence from other sequence analysis program into
WinMelt/MacMelt.
Print
The Print button will print the contents of the active window. The command will
open the standard Print dialog box that will allow you to select printing options. If the active
window is the Graph View, the graph and graphed sequence information will be printed. If the
active window is the Project View, one or all sequences will be printed. If only one sequence
is selected in the Project View, only that sequence will be printed.
New Sequence
The New Sequence button will insert an empty sequence into the project. There can
be a maximum of 50 sequences in one project.
Import Sequence
The Import Sequence button will import a sequence from a text file into the current
project. A standard File Open dialog box will be shown to select the file containing the
sequence. The sequence will be truncated to 10,000 nucleotides if longer (9,000 in Windows
3.1x). Only the nucleotide symbols "acgtu and ACGTU" are allowed. Other symbols will be
removed from the sequence. Sequence files in GenBank, EMBL, FASTA, or plain text
format will be automatically recognized.
In WinMelt the dialog box will initially show only files ending with the ".dna" extension.
Select "All files (*.*)" to show all files.
Display Sequence
The Sequence Display button will open the Sequence Display window of the selected
sequence from the project. The Sequence Display window allows editing of the sequence,
the description, melt probability calculation, and graphing option.
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Show or Hide Graph
The Show or Hide Graph button will show or hide the Graph View.
Edit Graph Axis
The Edit Graph Axis button allows the axis of the graph to be changed. The
temperature range (y-axis) can be adjusted from 0–120 °C. The sequence position (x-axis)
can be adjusted from 0–10,000 base-pairs.
Help
The Help button will display on-line help information for the program. The information will be similar to the software manual.

Section 10
Troubleshooting
Can not import sequence
You have tried to import a sequence or create a new sequence when the project is already
full with 50 sequences. Delete another sequence from the project first, or divide the project into
two project files.
Invalid file format
The file you tried to open is not a WinMelt/MacMelt project file. To import a sequence from
a text file, use the Import command on the sequence menu instead.
Out of memory
There is too little memory available for the program. Close other applications, reduce the
number of sequences in the project or reduce the length of the sequences. You may need to
restart your computer.
Illegal character entered—use A, C, G, T, or U in upper or lower case
You have tried to enter an illegal character into the sequence. The program will only allow the
following characters: acgtu and ACGTU.
The maximum sequence length (10,000) has been reached
You have tried to enter more than 10,000 characters into one sequence (9,000 in Windows
3.1x). The program cannot handle longer sequences and sequence information greater than
10,000 bases will be removed. Split the sequence into smaller portions.
Unable to create image file
The program was unable to create an image file. The disk is full or write-protected.
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